
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

USER GUIDE  
http://www.SuperProfitScalper.com 



DISCLAIMER 

 

Please be aware of the loss, risk, personal or otherwise consequences of the use 
and application of this book’s content. The author and the publisher are not 
responsible for any actions that you undertake and will not be held accountable 
for any loss or injuries. 
 

U.S. Government Required Disclaimer - Commodity Futures Trading 
 

Commission Futures and Options trading has large potential rewards, but also large 
potential risks. You must be aware of the risks and be willing to accept them in order 
to invest in the futures and options markets. Don't trade with money you can't afford 
to lose. This is neither a solicitation nor an offer to Buy/Sell futures or options. No 
representation is being made that any account will or is likely to achieve profits or 
losses similar to those discussed on this website. The past performance of any 
trading software or methodology is not necessarily indicative of future results. 
 
 

CFTC RULE 4.41 - HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS 
HAVE CERTAIN LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, 
SIMULATED RESULTS DO NOT REPRESENT ACTUAL TRADING. ALSO, SINCE 
THE TRADES HAVE NOT BEEN EXECUTED, THE RESULTS MAY HAVE 
UNDER-OR-OVER COMPENSATED FOR THE IMPACT, IF ANY, OF CERTAIN 
MARKET FACTORS, SUCH AS LACK OF LIQUIDITY. SIMULATED TRADING 
PROGRAMS IN GENERAL ARE ALSO SUBJECT TO THE FACT THAT THEY ARE 
DESIGNED WITH THE BENEFIT OF HINDSIGHT. NO REPRESENTATION IS 
BEING MADE THAT ANY ACCOUNT WILL OR IS LIKELY TO ACHIEVE PROFIT 
OR LOSSES SIMILAR TO THOSE SHOWN. 
 
 

No representation is being made that any account will or is likely to achieve profits 
or losses similar to those shown. In fact, there are frequently sharp differences 
between hypothetical performance results and the actual results subsequently 
achieved by any particular trading program. Hypothetical trading does not involve 
financial risk, and no hypothetical trading record can completely account for the 
impact of financial risk in actual trading. All information on this website or any e-
book purchased from this website is for educational purposes only and is not 
intended to provide financial advice. Any statements about profits or income, 
expressed or implied, do not represent a guarantee. Your actual trading may result 
in losses as no trading software is guaranteed. You accept full responsibilities for 
your actions, trades, profit or loss, and agree to hold Super Profit Scalper and any 
authorized distributors of this information harmless in any and all ways. The use of 
this software constitutes acceptance of this user agreement. 



COPYRIGHT 
 

This book and software cannot be re-written, re-published, STORED OR LINKED 
AT ANY FILE SHARING SITES or FORUMS or used for any other books without 
proper referencing without permission. The use of the book and software is limited 
to your personal use only. Spreading out the copies without the agreement of the 
development team is illegal and protected by international copyright law. 
 

Copyright © www.SuperProfitScalper.com 
 

Introduction 
 

Thank you for your purchase of “Super Profit Scalper”! 
 

Super Profit Scalper software package includes: 
 

- Step-by-step users guide 
 

- Indicator’s secret trading algorithm explained in detail 
 

- Super Profit Scalper indicator software itself 
 

- Live Actions Screenshots 
 

- Sample Trades examples 
 

- Personal "I will help you" promise from the developer 
 

 

We used a very powerful trading logic for Super Profit Scalper. It works on M1 and 
M5 timeframes and it's main strong points are the speed and accuracy of signals. 
This new trading logic will enable Super Profit Scalper to generate super early 
signals right before the price starts moving fast into a specific direction. And when 
we can enter trades early, we can grab the maximum possible profit from every 
trade. I am sure you will enjoy trading with your indicator.  
 
If you have any questions, please contact me 
via email karl@karldittmann.com  

or fill out this contact form. 
 

I would love to help you! 
 

 

It's extremely important for you to fully understand how Super Profit 
Scalper works. Read this guide carefully, it has a lot of important 
information that could greatly improve your trading experience. 

mailto:karl@karldittmann.com
http://www.karldittmann.com/help.html


Please try using the indicator on a demo account first. Only move to trading with 
it on a live account, once you are completely familiar with Super Profit Scalper 
and fully understand all the simple rules on how to use it correctly. 
 

Do not hesitate to contact us if you have any questions! 
 

We wish you a great trading success! 
Karl Dittmann’s 
Trading Team 
 

www.SuperProfitScalper.com 
 



MT4 Installation and activation instructions 
 

NOTE 1: This product works on MT4 platform only. Trading tools created 
specifically for MT4 won't work on MT5 due to differences in the programming 
language. 
 

NOTE 2: Make sure to update your MT4 to the latest build. “Super Profit 
Scalper” is designed to give you best results and to work properly only with the 
latest version of MT4 platform. 
 

Activation of Your Product: 

 

This product will only work on a single trading account. You need to connect your 

Receipt Number or Order ID with your Trading Account Number. Here is how 
it’s done: 

 

Step 1) Open your MT4 and write down your Trading Account Number. 
It is written in the very upper left corner of the MT4 window. 
 
NOTE: If you have been looking for a reliable and honest broker, look no 
further. I have been trading with FX Choice for a while now and I am extremely 
happy with their service. 
 
Open a live account right now and receive a one-time 15% deposit bonus by 
following this link: https://my.myfxchoice.com/registration. 
           
Step 2) Write down your Receipt Number or Order ID: 
 
- Receipt Number is a unique number generated by ClickBank at the time of 
your order. It consists of 8 symbols (Example: Z6GH578D). Don't know your 
Receipt Number? Just check your inbox for an email from ClickBank and find it 
there. 
 
- Order ID is a unique number generated by ClickBetter at the time of your 
order. It consists of 10 numbers (Example: 0123456789). Don't know your Order 
ID? Just check your inbox for an email from ClickBetter and find it there. 
 
If you can’t find your Receipt Number or Order ID, please contact me 
via email karl@karldittmann.com or fill out this contact form. Please 
make sure to include the exact email address used for the purchase. 
 

https://my.myfxchoice.com/registration/?refer=320106
mailto:karl@karldittmann.com
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Step 3) 
 

- Go to www.license.karldittmann.com 

- Click on “Register Product License (New)”  
 

  

 
 
 
 
 
 
 
 
 
 
 
 
- You will arrive at the page shown below: 
 

 
 

- Enter your Receipt Number or Order ID  

(click on “?” if you are not sure what you should type in) 

- Enter the password (make sure to write it down) 
- Repeat the password  

http://www.license.karldittmann.com/


- Click on “I’m not a robot”  
- Click on “Create account” 
 

Step 4) You will arrive at the page shown below:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Now, simply enter Your Trading Account Number and click “Save” 

 

Reminder: Your Trading Account Number can be found 
in the upper left corner of the MT4 window. 

 
How to change your Trading Account Number: 

 

Step 1) 

 

- Go to www.license.karldittmann.com  
- Click on “Update Product License (Existing)” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

http://www.license.karldittmann.com/


Step 2) You will arrive at the page shown below: 
 

 
  

- Enter Your Receipt Number or Order ID 

(click on “?” if you are not sure what you should type in) 

- Enter your password (password used for registration) 
- Click on “I’m not a robot” 
- Click on “Login” 
 
Step 3) You will arrive at the page shown below:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Now, simply delete the previous Trading Account Number, enter the new one 
and click “Save” 

 

 



NOTE: You only have 2 Attempts to enter your Trading Account Number. If you 
run out of attempts and need to change your Trading Account Number again, 
please contact me via email karl@karldittmann.com or fill out this contact 
form. Please make sure to include your order number. 

mailto:karl@karldittmann.com
http://www.karldittmann.com/help.html
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Installation of Your Product: 

 

Step 1) Unzip the zip file that you have downloaded: 

  

There you will find the indicator file which name is 

SuperProfitScalper.ex4 

Step 2) 

 

1) Open your MT4 platform 

 
2) Click File — Open Data Folder. Here you will find a folder called MQL4. 

 
3) Open folder MQL4. Here you will find Indicators folder. Copy your 
Indicator (ex4) file into MQL4/Indicators folder. Do this by right clicking on 
the file and clicking ―copy and then ―paste. 
 
4) Restart your MT4. 

 

If you have any difficulties, please contact me  

via email karl@karldittmann.com or fill 
out this contact form. 
 

 

Step 3) Open the MetaTrader® platform, 
and click on View -> Navigator.  
 
 

You can also press CTRL+N. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click on 'Navigator's 

 

Step 4) A window titled 'Navigator' will appear. Double click on Indicators  

mailto:karl@karldittmann.com
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Step 5) You should now see the Super Profit Scalper in the Indicators 
folder. 
Drag and Drop the Super Profit Scalper file onto your chart. 
 

Step 6) Once you attach Super Profit Scalper, make sure to enable the two 
options as shown below and only then click OK.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Step 7) If the following message box appears on your chart, follow the 
activation instructions shown below.  
 

 

 

Step 8) Done. Enjoy your trading! 

 

IMPORTANT: Please be advised that for the product to work, your order must 
remain active. Refunding the product will deactivate its license immediately. 

 

If you need any assistance, please contact me via email 
karl@karldittmann.com or fill out this contact form. 
 

I would love to help you. 

mailto:karl@karldittmann.com
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MUST READ RULES on how to use “Super Profit Scalper” 
 

 

Rule #1: 
 

Do not use the indicator on a flat market! Use the indicator ONLY 
during active market hours – for example London session, US session. 
 

Trend will not be noticeable on a weak market (night time, Christmas period, 
other holidays etc…) keep reading and I will explain everything... 
 

 

Rule #2: 
 

- Identify a global trend. (Remember? Trend is your friend!) 
- Ignore all signals against a current GLOBAL trend! 
- Do not use the indicator on a sideways trend. 
 

 

Rule #3: 
 

Before entering a trade or while in a trade, make sure to check 
news calendar like this one: http://ec.forexprostools.com 
(CTRL + D to bookmark it) 
 

If you get a signal from "Super Profit Scalper" and the above 
calendar shows that important news announcement is 
about to come or just happened already - better avoid that signal. 
Big news can make the market go against you in no time. 
 

NOTE A) It's better to enter a trade when there are no news 
announcements or when there is news only with low importance. 
 

NOTE B) If you are already in a trade and see that there is a 
highly important news announcement coming out soon (that 
affects the pair you are trading on) - exit the trade as soon as 
possible. 
 

The above calendar shows 1 image of a bull for news with 
low importance, 2 bulls for medium importance and 3 
bulls for high importance. 
 
 
 
 

http://ec.forexprostools.com/
http://ec.forexprostools.com/


Informer 
 

Super Profit Scalper has been enhanced with a smart informer system, which is 
designed to make your trading more pleasant and convenient.  
 
 

 

 
- Indicator name 

- Current trading style  

- Current signal 

- Time until next candle  

- Current time 
 
 

 

 

 

 

 

 

Stop Loss 
 

Option 1 (Recommended) 
 

Use the exact StopLoss Value shown in the 

alerts or on the trading charts themselves. 
 

Option 2 
 

A lot of traders usually calculate StopLoss with this formula: 
Previous bar high (for SELL entries) or low (for BUY entries) 
+ spread + extra number of pips. 
 

 

IMPORTANT: Set StopLoss for ALL your trades and DO NOT deviate from it.  

This will protect you from major capital losses.



Entering Trades  
 
 

BUY when a Purple Line starts. 
(As shown on the screenshot to 
your left)  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Sell when a Yellow Line starts. 
(As shown on the screenshot to your right) 



Exiting Trades 
 

Option 1 

 

Exit your trades when the Super Profit Scalper issues the opposite 
trading signal. This ensures that you trade with maximum profits 
and exit right before the market is expected to reverse. 
 

If you enter with BUY 
(Purple Line) 
-Exit as soon as a Yellow Line starts. 
 

 

If you enter with SELL 
(Yellow Line) 
-Exit as soon as a Purple Line starts. 
 

Option 2 

 

You can also exit according to the Take Profit (TP) level that is shown in the 
popup alert window. This is a very good method that a lot of traders use. 
 

You can adjust Take Profit in the indicator INPUTS 
depending on the time frame you are using. 
 

Option 3 

 

Another exit mechanism which is highly effective is to exit near strong support 
or resistance levels. It is a method that generates exits earlier, so you take profits 
early. Good method if you prefer trading in a more safe manner. 
 
 
 
 
 

 

Time Frames and Pairs 
 

-M1 and M5 only. 
 

-Works on all major pairs 
 

Best results on EUR/USD, GBP/USD, USD/JPY, EUR/JPY, GBP/JPY, 
NZD/JPY, USD/CHF, and USD/CAD. 



 
Input Parameters: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

All the Inputs are ready to use/trade by default. You don’t have to 
change anything. Please read the next page for details on each 
parameter in case you want to experiment with any of them. 

 
______________________SETTINGS_____________________ 
 

Trading Style is the most important parameter. It’s set to "Medium" by default 
and this is the optimal Trading Style for this indicator. There are 4 modes of 
Trading Style: 
 

1) Conservative - Concentrates on safety rather than on speed of signals. 
2) Medium - Combination of conservative and aggressive signals.  
3) Aggressive - Concentrates on speed of signals rather than safety.  
4) Custom - Allows you to take full control of the signals and manually 

configure them to match your preferences. 
 
Period Setting allows you to manually configure signals of the indicator. 
Once Custom Trading Style is selected, choose preferred value for Period 
Setting. Period Setting works ONLY when the Trading Style is set to Custom. I 
don’t recommend experimenting with this unless you know what you are 
doing.  

If you still want to experiment, try values in this range: 1-20. 
 



Stop Loss allows you to manually configure StopLoss value. Set to 5 by default. 
(Shows as 50) 
 
StopLoss Notice: No matter if you are using 4 or 5 digits broker, the 
indicator will adjust StopLoss accordingly. So if you decide to change 
StopLoss, just remember to follow this formula: 100=10 Pips. The indicator 
will automatically adjust this value. 
 

So for example, you want to set StopLoss to 20 pips (no matter if you are using 
4 or 5 digit broker) just enter StopLoss 200 and the indicator will automatically 
turn it into the appropriate value for your broker. If you are using 5 digit broker 
and want to set StopLoss to 20 pips, you will still have to enter 200. 
 
Recommendation: Using preset value for StopLoss is optimal and 

recommended. Change them only if you know what you are doing. 

 
Take Profit allows you to manually configure StopLoss value. Set to 10 by 
default. (Shows as 100) 
 
Info Position is responsible for moving the informer in any of the corners of 
your trading chart. It's useful to change this parameter when the info box is 
coming on top of the price and makes the signals hardly visible. 
 

Left Upper – Upper Left Corner 
Right Upper – Upper Right Corner 
Left Lower – Bottom Left Corner  

Right Lower – Bottom Right Corner 
 

Tip: To remove the informer from the current chart, set Informer Position 

value to “Don't Show Informer”. To put it back on, use any other value. 
 

Circles Size and Lines Width are responsible for changing the size and 
width of the elements of the signal line. 
 

_______________________COLORS______________________ 
 

Buy Color changes the color of dotted BUY signal lines. Set to BlueViolet by 
default. 
 
Sell Color changes the color of dotted SELL signal lines. Set to Yellow by 
default. 



_______________________ALERTS______________________ 
 
Popup Sound Alert is responsible for generating Popup Sound Alerts on your 
computer screen. Popup Sound Alert is set to "true" by default. This option can be 
turned off by selecting “false”. 
 

Email Alert is responsible for sending email alerts to your email. Email Alert is 

set to "false" by default. This option can be turned on by selecting "true". 
 

Push Notification is responsible for sending push notifications to your mobile 
device. Push notification is set to "false" by default. This option can be turned on 
by selecting "true". 
 
 
 

Popup Alert Window:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

EURUSD, M5 – Pair, Timeframe  
BUY/SELL @ Price – Signal and Entry Price 
TP – Take Profit 
SL - Stop Loss 

 



EMAIL alert setup: 
 

Setup your metatrader4 to send email:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Email alert must be activated in the Super Profit Scalper 
INPUTS. After it’s activated, all you have to do is setup 
your own mail server info… 
 

Email setup can be done in: Tools => Options => Email 

 

If you need more info on how to setup an email alert, please go to youtube.com 
and search for mt4 email setup. There are plenty of detailed explanation videos. 



Push Notification Setup: 
 

Push notifications will be sent to your mobile device via MT4 app and they will 
include all the information about every signal generated by Super Profit 
Scalper.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To set up push notifications, please follow these steps: 
 

1) Download and install MetaTrader 4 application from appstore or google 
play depending on the device you are using. 
 
2) Open the MetaTrader 4 application on your device. Go to Settings and look 
for MetaQuotes ID. It's a combination of numbers and letters. Write this as we 
are going to need it. 
 
3) Open MetaTrader 4 on your computer and go to Tools->Options-> Notifications. 
Enable "Enable Push Notifications", enter your MetaQuotes ID and click OK. 
 
4) Done! Attach Super Profit Scalper to a chart of your choice and 
enjoy push notifications sent directly to your mobile device! 
 

Please note: For push notifications to work, Super Profit Scalper must be 
attached to a chart, Push Alert in the indicator inputs must be set to "true", 
your computer and mobile device must be connected to the internet. 



Recommendations 
 

Use the indicator ONLY during ACTIVE market!  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Do not use the indicator on a weak/slow market – outside 
recommended trading hours (London or US sessions). Signals 
never work well on a weak market; this has been proven many 
times… 
 

The London session is the largest market  
and it opens at 08:00 GMT or 03:00 EST  
and closes at 17:00 GMT or 12:00 EST. 
 

Trading is best between 08:00 GMT and 10:00 GMT 
 

The New York session opens at 13:00 GMT 
 

or 08:00 EST and closes at 22:00 GMT or 17:00 EST. 
 

The best trades occur in the first 2-3 hours. 
 

The time is shown in 24:00 format. 
 



IMPORTANT: It is extremely important to trade only following the current 
trend! It will cut BIG MAJORITY of bad trades! Avoid trading against trend at all 
times. 
 

To properly determine the direction of the trend, always refer to 1-2 timeframes 
higher than your current timeframe (if trading on H1, check trend direction on 
H4 or D1). 
 

Example: 
 

Trend is UP and the indicator generates a Purple BUY Line – it’s OK to open 
the trade. 
 

Trend is DOWN and the indicator generates a Yellow Sell Line – it’s OK to 
open the trade. 
 

Trend is UP and the indicator shows a Yellow Sell Line – NO TRADE! 
 

Wait for the next BUY signal. 
 

Trend is DOWN and the indicator shows a Purple BUY Line – NO TRADE! 
Wait for the next SELL signal. 
 

Also, stay away from trading completely when the market is flat. 
 

Stay away from using the signals when you see unclear trend, flat or 
sideways trends – example: 
 

 

 

 

 

 

 

 

 

Please follow these just explained rules and all rules mentioned in this user 
guide to achieve best results. Don’t ignore them as they are designed to help 
you. 



Money Management Rules 
 

Money management is a very important concept that has an enormous effect on 
drawdown and margin calls. The cardinal rule of money management is the 
following: 
 

Rule 1) Never risk more than 1-3% of your deposit on any single trade. 
 

You may have heard this rule a hundred times before, but it is amazing to see how 
many good traders fail to comprehend this concept – and don't understand why 
they are wiped out again and again, despite great entries and timing of trades. 
 

StopLoss is calculated regardless of your level of risk or your equity, 
and is based solely on price-action. After deciding on the StopLoss, enter it together 
with your deposit size and desired Risk % in a Lot Size calculator. 
 

To calculate Lot Size, you can use this online calculator: 
https://www.myfxbook.com/forex-calculators/position-size 
 

Rule 2) Never gain or lose more than 10% of your deposit in any single 
day. 
 

1) For example your deposit is 100%. 
 
2) Each trading day should either result in a 10% gain or 10% loss. Never more 
than 10%. 
 
3) Let’s imagine that out of 5 trading days, we had 3 profitable days (10% gain 
each day) and 2 losing days (10% loss each day). 
 
4) According to this example, by the end of the trading week we would have made 
10% profit. Here is the formula: 
100%(Deposit) + 30%(Profitable Days) - 20%(Losing Days) = 110% 
 

If we didn't use this method, some of our losing days could have resulted in more 
losses (for example 15% or 25%) and in the end 
 

of the trading week, we could have been left with 50% of the deposit. 
 

I hope now you understand why it is important to never gain or lose more than 
10% of your deposit in 1 trading day. Never try to double your deposit in 1 day and 
always stop trading once you have lost 10% of your deposit. Slow and steady wins 
the race. 
 

Rule 3) Never use Martingale Strategy! 
 

This is a very unsafe money management strategy that promotes increasing Lot 
Size after every loss. At first, this might seem as a good method to cover a previous 
loss and make profit, but actually, it almost always leads to burning entire 
deposits. 

https://www.myfxbook.com/forex-calculators/position-size


More trades examples:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

If you have any questions, please contact me via email 
karl@karldittmann.com or fill out this contact form. 
 

I will do my best to help you as soon as possible. 
 

Best of Luck! 
Karl Dittmann 
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